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Safety Notices

A CAUTION notice denotes a hazard. It
calls attention to an operating proce-
dure, practice, or the like that, if not
correctly performed or adhered to,
could result in damage to the product
or loss of important data. Do not pro-
ceed beyond a CAUTION notice until
the indicated conditions are fully
understood and met.

A WARNING notice denotes a hazard.
It calls attention to an operating pro-
cedure, practice, or the like that, if not
correctly performed or adhered to,
could result in personal injury or
death. Do not proceed beyond a
WARNING notice until the indicated
conditions are fully understood and
met.
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Safety Summary

General
Before Applying
Power

Ground the
Instrument

Fuses

Do Not Operate in
an Explosive
Atmosphere

Do Not Remove the
Instrument Cover

Cleaning

Do Not Modify the
Instrument

In Case of Damage

The following general safety precautions must be observed during all phases of operation of this
instrument. Failure to comply with these precautions or with specific warnings or operating
instructions in the product manuals violates safety standards of design, manufacture, and intended
use of the instrument. Keysight Technologies assumes no liability for the customer's failure to comply
with these requirements. Product manuals are provided with your instrument on CD-ROM and/or in
printed form. Printed manuals are an option for many products. Manuals may also be available on
the Web. Go to www.keysight.com and type in your product number in the Search field at the top of
the page.

Do not use this product in any manner not specified by the manufacturer. The protective features of
this product may be impaired if it is used in @ manner not specified in the operation instructions.

Verify that all safety precautions are taken. Make all connections to the unit before applying power.
Note the instrument's external markings described in “Safety Symbols”.

If your product is provided with a grounding type power plug, the instrument chassis and cover must
be connected to an electrical ground to minimize shock hazard. The ground pin must be firmly
connected to an electrical ground (safety ground) terminal at the power outlet. Any interruption of
the protective (grounding) conductor or disconnection of the protective earth terminal will cause a
potential shock hazard that could result in personal injury.

See the user's guide or operator's manual for information about line-fuse replacement. Some
instruments contain an internal fuse, which is not user accessible.

Do not operate the instrument in the presence of flammable gases or fumes.

Only qualified, service-trained personnel who are aware of the hazards involved should remove
instrument covers. Always disconnect the power cable and any external circuits before removing the
instrument cover.

Clean the outside of the instrument with a soft, lint-free, slightly dampened cloth. Do not use
detergent or chemical solvents.

Do not install substitute parts or perform any unauthorized modification to the product. Return the
product to an Keysight Sales and Service Office for service and repair to ensure that safety features
are maintained.

Instruments that appear damaged or defective should be made inoperative and secured against
unintended operation until they can be repaired by qualified service personnel.

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice,
or the like that, if not correctly performed or adhered to, could result in damage to the
product or loss of important data. Do not proceed beyond a CAUTION notice until the
indicated conditions are fully understood and met.

A WARNING notice denotes a hazard. It calls attention to an operating procedure,
practice, or the like that, if not correctly performed or adhered to, could result in
personal injury or death. Do not proceed beyond a WARNING notice until the indicated
conditions are fully understood and met.
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Safety Symbols

Table 1 Safety Symbol

Symbol Description

cl ¢

P

IGO0~ EHFI®IS

Direct current

Alternating current

Both direct and alternating current

Three phase alternating current

Three phase alternating current

Earth ground terminal

Protective earth ground terminal

Frame or chassis ground terminal

Terminal is at earth potential

Equipotentiality

Neutral conductor on permanently
installed equipment

Line conductor on permanently installed
equipment

On (mains supply)

Off (mains supply)

Stand by (mains supply). The instrument is
not completely disconnected from the
mains supply when the power switch is in
the standby position

In position of a bi-stable push switch
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Description

(72
<
3
=3
=3

U RE@> >0

CAT I

Out position of a bi-stable push switch

Equipment protected throughout by
DOUBLE INSULATION or REINFORCED
INSULATION

Caution, refer to accompanying
documentation

Caution, risk of electric shock

Do not apply around or remove from
HAZARDOUS LIVE conductors

Application around and removal from
HAZARDOUS LIVE conductors is
permitted

Caution, hot surface

lonizing radiation

IEC Measurement Category |
Measurement Category Il
Measurement Category Il

Measurement Category IV
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Compliance and Environmental Information

Table 2 Compliance and Environmental Information

Safety Symbol Description

CSA is the Canadian certification mark to demonstrate compliance with the Safety
S © requirements.

Agency of Australia. This signifies compliance with the Australia EMC
Framework regulations under the terms of the Radio Communication Act

N10149 of 1992.

CE compliance marking to the EU Safety and EMC Directives.
ISM GRP-1A classification according to the international EMC standard.

ICES/NMB-001 compliance marking to the Canadian EMC standard.

o The C-tick mark is a registered trademark of the Spectrum Management
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Real-Time Compliance Tool
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Introduction

How the Real-Time Compliance Tool Works / 10
Flow of Steps / 11

The Real-Time Compliance tool evaluates DDR/LPDDR data in real-time to detect and report
violations to compliance limits specified in DDR/LPDDR specifications. Unlike the DDR Post Process
Compliance tool that evaluates the data captured in a trace for violations, this tool evaluates
real-time data captured by an Keysight logic analyzer module.

The Real-Time Compliance tool can evaluate DDR, DDR2, DDR3, DDR4, LPDDR, LPDDRZ2, and
LPDDR3 target systems for compliance violations.

Besides providing predefined compliance tests for DDR/LPDDR, the tool also allows you to create
and run user-defined tests for DDR/LPDDR or any other general-purpose tests.
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Introduction

How the Real-Time Compliance Tool Works

The tool allows you to load, configure, and run a set of compliance tests on the real-time data being
captured from a DDR/LPDDR target system.

You can either run compliance tests from the set of predefined tests available with the tool or create
and run your own compliance tests to suit your specific requirements.

Each predefined compliance test has an associated specification parameter based on which one or
more trigger condition(s) are defined. For example, the test displayed in the screen below has a
trigger condition based on the tRASmin specification parameter.

= W DDR3 Tests
= [ ACTIVATE to PRECHARGE must be == tRASmin
= ¥ Chip select 0
[¥ Bankd
[¥ Bank1

When the test is run, the tool checks the real-time data for compliance limit violations as per the
trigger condition(s). On encountering a violation, the trigger condition is met and Logic Analyzer is
triggered to report it as a violation. Besides reporting the violation, the tool also performs any
additional actions (such as saving the violation trace) that you have configured it to perform in the
event of a violation.

In case the tool does not detect any violations within the time that you specified for the execution of
the test, the tool stops the current test and starts running the next test in the sequence. If all tests
have already been run, then the tool stops.

The tool uses the trigger specifications specified for the Logic Analyzer module to run tests on valid
captured data. The trigger specifications are already defined for the predefined tests that ship with
the tool. For user-defined tests, you need to define the trigger specifications.

There are some tests that cannot be run real-time. For such tests, you need to
use the DDR Post Process Compliance tool.

Real-Time Compliance Tool User Guide



Introduction 1

Flow of Steps

The following screen displays a general sequential flow of steps for using the Real-Time Compliance
tool.

Load a user-defined or
predefined testgroup

Selectthe compliance
test(s) you wantto run
from the test group

defaultvalue of the
specification parameter
associated witha test

!

Configure the action(s) to
be taken on detecting a
viclation

Run the selected tests and
view test results

Sawve the tool setup for
future use

These steps are described in detail in the topics that follow.

Real-Time Compliance Tool User Guide 11
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Before You Start

Before you start using the tool, ensure that you have:

1

Installed the Keysight Logic and Protocol Analyzer software version 5.50 or higher. The
Real-Time Compliance tool works with this software.

Installed the Real-Time Compliance tool’s software and enabled its license. The Real-Time
Compliance tool is a part of the B4622B DDR Protocol Compliance and Analysis toolset.
Therefore, the tool is available only after you install the Keysight B4622B DDR2/3 Protocol
Compliance and Analysis Tool package.

You can install the Keysight Logic and Protocol Analyzer application and Keysight
B4622B DDR2/3 Protacol Compliance and Analysis Tool package from the Keysight web
site at: www.keysight.com/find/la-sw-download.

After installation, you must enable the software license by following the instructions on your
Entitlement Certificate.

The following two licensed options of the B4622 software are currently available.
B4622A license

B4622B license

B4622B is an upgrade license. You get the Real-Time Compliance tool only with the

B4622B license. With the B4622A license, you cannot launch and use the tool. Doing so,
results in the display of an error message.

Contact Keysight Technologies to purchase the upgrade license.

Accurately set up the hardware and software of the Keysight logic analyzer to capture the
required data of the DDR-type bus being monitored. Doing so ensures that you have valid data on
which to run compliance tests to detect violations.

Refer to the Keysight Logic and Protocol Analyzer Online Help to know how to set up the
Keysight logic analyzer to capture the required data.

Refer to the DDR Setup Assistant Online Help to know how to set up your logic analyzer properly
for DDR/LPDDR data capture and analysis.


www.keysight.com/find/la-sw-download

2 Before You Start
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3  Starting the Real-Time Com-
pliance Tool

The Real-Time Compliance tool is accessible from the Keysight Logic and Protocol Analyzer GUI.
To start the Real-Time Compliance tool

1 Select Tools > External Applications > Real-Time Compliance Tool from the Keysight Logic and
Protocol Analyzer GUI menubar.

w Markers BunfStop Owerview ‘Window Help
! E Mew Bus Analysis 3 JJ 2. T3 JJ e T JJ g JJ +5 3
! E Mew Inverse Assembly L4

"?; Mew FilkerCalorize. .
i J hew Packet Decoder, ..
: l[” Mew Signal Extrackaor, .,

o1+ News SerialToParallel. . aslz nEEEE
| & Gweryview (Re-order, Delete, ete,) AlE-0
ik Eind... ChrlHF
I Manage Protocals. ..
External Applications DOR Trigger Tool

DDR Post Process Compliance Tool

Macro L4

Real-Time Compliance Tool
Run Macro r

DDR Performance Tool
1 DDR Bus Decoder-1 L4

Setup...

The Real-Time Compliance Tool is displayed.
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3

Starting the Real-Time Compliance Tool

Real-Time Compliance Tool =]

Setup | Fun Options | Run/Reasults |

Select logic analyzer module: | DDR3 W36334 |

Manage Test Groups

Test Group Name | Deascription Load Test Group...

Remove |

4| | ﬂ Edit Parameters... |

— Select Tests to Run Test Selection Shortcuts

— Test Time
Total Estimated Test Fun Time: 1 Day 14 Houwrs 40 Minutes

Specify Time to Run Each Test...

At times, you may get the following error message when trying to launch the Real-Time Compliance
tool.

o licenses for the "Real-time validation tool" are available on this system.
To see more dekails on licenses select the Help-=Saftware Licensing. .. menu
itern in the main logic analvzer application.

Conkack waur icense server administrakar ko see if there is anokher server
that has the appropriate license,

If wou need ko purchase a license For the "Real-time walidation kool”, contact
vour Agilent Technologies, Inc, sales representative,

This error message indicates that the B4622B upgrade license needed for this tool is not currently
available on the system. To access the tool, you need to purchase and install the B4622B upgrade
license.

Real-Time Compliance Tool User Guide
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4 Loading, Configuring, and Se-
lecting Compliance Tests

Test Groups, Tests, and Specification Parameters / 18
To load a test group / 19

To select compliance tests / 20

To edit specification parameters / 22

Specifying Test Execution Time / 25

Configuring the Tool’s Run Options / 27
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4 Loading, Configuring, and Selecting Compliance Tests

Test Groups, Tests, and Specification Parameters

Compliance tests are grouped as test groups and stored in XML files. For instance, the DDRS3 tests

are grouped and stored in the DDR3Tests.xml file.

When you install the Real-Time Compliance tool, a set of predefined test groups (XML files) are

installed at the following location.

C:\Program Files (x86)\Keysight Technologies\Logic Analyzer\ExternalApps\

RealTimeComplianceTool\Test Group Files

You first need to load a required test group XML file, then select the tests that you want to run from
that test group, and if required edit the specification parameters of tests.

The following screen displays a loaded test group XML file and the tests that it contains along with

the associated specification parameter for each test.

Real-Time Compliance Tool H=]
Setup | Fun Options | Run/Results |
Select logic analyzer module: | DDR3 W36334 ¥ |
Manage Test Groups
Test Group Name | Description | pad Test Grou pl
DDR3 Tests Compliance tests for DDR3
Remove |
‘l | _,I Edit Parameters... |

— Selact Tests to Run Test Selection Shurtcutsl

Test Group

E [T DDR3 Tests
I- ACTIVATE to PRECHARGE must be == tRASmIn

ACTIVATE to READ/WRITE must be >=[RCD ]
PRECHARGE to ACTIVATE must be == tRP
READ to PRECHARGE must be == tRTP

READ toc WRITE must be »== tDRW

[ EEE
I

Tests

ACTIVATE to PRECHARGE/autoPRECHARGE must be <

Specification Parameters

Real-Time Compliance Tool User Guide



To load a test group

N —

Loading, Configuring, and Selecting Compliance Tests

Click the Setup tab in the Real-Time Compliance tool.

From the Select logic analyzer module listbox, select the logic analyzer module that you are using
for capturing DDR data. If more than one module exists in the setup, you need to select which
one to use for running the compliance tests. If only one module exists, it will be selected

automatically.
3 Click the Load Test Group... button.
4 Browse and select a predefined or a user-defined test group XML file and click Open.

4

On loading the test group XML file, all the tests included in the group are displayed in the Real-Time
Compliance tool.

Real-Time Compliance Tool =]

setup | Fun Qptions | Rumn/Results I

Select logic analyzer module: | DDR3 W36334 7

Mamage Test Groups

Test Group Name | Description  |oad Test Group...|

4|

DOR3 Tests Compliance tests for DDR3 |

Remove

| _FI Edit Parametzrs... |

— Select Tests to Run Test Selection Short-:utsl

FEEEEEEEEEEEEEEEEEEEE EEEE
B e e L I

Real-Time Compliance Tool User Guide

B [T DDR3 Tests
[T ACTTVATE to PRECHARGE must be == tRASmIn

ACTIVATE to PRECHARGE/autoPRECHARGE must be < tRASmax
ACTIVATE to READ/WRITE must be == tRCD

PRECHARGE to ACTIVATE must be == tRP

READ to PRECHARGE must be == tRTP

READ to WRITE must be == tDRW

WRITE to PRECHARGE must be == t{DWP

WRITE to READ must be == tDWR

WRITE to WRITE must be == tCCD

REFRESH to valid command {non-MOP/DES) must be == tRFC
ACTIVATE (any bank) to ACTIVATE (anv bank) must be == tRRD
ACTIVATE to ACTIVATE (same bank) must be == tRC
READ/WRITE to an inactive bank

REFRESH command to an active bank

ACTIVATE command to an active bank

REFRESH to REFRESH <= tREFI * @

Long cal {mormal operation) to valid command must be == tZQoper
Short cal (mormal operation) to valid command must be == t7QCs
MRS {Mode Register Set) to MRS must be == tMRD

MRS {Mode Register 5et) to valid command must be == tMOD
REFRESH to power down entry == tREFPDEN

READ to power down entry == tRDPDEM

WRITE to power down entry == tWRPDEN

Exit RESET from CKE high to valid command == t{PR

Self Refresh Exit to valid command with DLL must be == t{SDLL
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4 Loading, Configuring, and Selecting Compliance Tests

To select compliance tests

You can choose to run all or some of the tests included in the loaded test group. By default, none of

the tests in a group are selected.

By selecting the checkbox displayed with the test group name, all the tests in that group are selected
to run. To include specific tests for execution, select the checkbox displayed with each of the

individual test you want to run.

Expanding a test allows you to further narrow down the test execution to selective Chip selects and
banks. For example, in the screen below, the first test is run only for Bank 0-2 of Chip Select 0.

Real-Time Compliance Tool

Setup | Fun Options | Run/Results |

Select logic analyzer module: | DDR3 W36334 |
Manage Test Groups

=] E3

Test Group Name I

Description | pad Test GFDIJD...I

DDR3 Tests Compliance tests for DDR3

4 |

Remove I

ﬂ Edit Parametars.., I

— Select Tests to Run  Test Selection Shurt{utsl

= [ DODR3 Tests
E W ACTIVATE to PRECHARGE must be »= tRA4Smin
= W Chip select 0

v Bank 0
Bank 1
Bank 2
Bank 3
Bank 4
Bank 3
Bank &
Bank 7

ip Select 1

Bank 0
Bank 1
Bank 2
Bank 3
Bank 4
Bank 3
Bank &
Bank 7

=

T2 TR

.

[»

If you want to run all tests in a test group for a particular chip select, then instead of expanding each
test and selecting the specific chip select checkbox, you can use the Test Selection Shertcuts option.
Clicking this option displays options to select all tests for a particular chip select in a single click.

20
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Loading, Configuring, and Selecting Compliance Tests 4

Real-Time Compliance Tool =] B

setup | Fun Qptions I Run/Results |

Select logic analyzer module: | DDR3 W3633A |

Manage Test Groups
Test Group Name | Description | gad Tast Gruup...l
DORS Tests Compliance tests for DDR3
Remowe |
4l [ _,I Edit Parameters... |

— Selact Tests to Run  Test Selection 5hnrtcuts|

Select all "Chip Select 0" tests
= [ DDR3 Tests e le Lensas T

[~ ACTIVATE to PRECHARGE must  Select all "Chip Select 1" tests
ACTIVATE to PRECHARGE/autof  Select all “Chip Select 2" tests
ACTIVATE to READ.I"I."'J'R_H-E mus celect all “Chlp Select 3" tests
PRECHARGE to ACTIVATE must se—sre—cre

READ to PRECHARGE must be >= tRTP

® B EEE
7
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4 Loading, Configuring, and Selecting Compliance Tests

To edit specification parameters

Each compliance test has a specification parameter associated with it. The default value of each
specification parameter is already set. If required, you can override the default value and provide a
desired value suitable for your specific requirements such as bus speed and bus type.
You can override the default value of specification parameters in the following two ways:
Manually override the default value of a particular specification parameter.
Apply a Parameter Value XML file to change the value of all the specification parameters in a test
group to the values appropriate for a particular bus speed. A number of predefined Parameter

Value XML files are installed with the Real-Time Compliance tool for the most common bus
speeds for all DDR bus types. These files are installed at:

C:\Program Files (x86)\Keysight Technologies\Logic Analyzer\ExternalApps\
RealTimeComplianceTool\Parameter Value Files

Applying a Parameter Value file quickly changes all the parameter values to match the values
applicable for a particular bus speed.

Manually Overriding the Default Value of a Parameter

In the Real-Time Compliance tool, load the required test group.
2 Click the Edit Parameters... button displayed in the Setup tab.

The Edit Test Parameters dialog box is displayed with the list of all the specification parameters
applicable for the test group.

Edit Test Parameters _ O] =
The valuas of anv of the listed DDR3 specification narameters can be overridden. Enter all values as an integer
representing twice the number of clocks (CKD). (This is because there are two logic analyzer states per clock,)
For example, to st a parameter to 10 docks, enter a value of 20,

Apphy Parameter Values FlIE...l

¥ tRASmiIn

I

¥ tRASmax

™ tRCDC and tRP
v tRTP

¥ tDRW

w  tDWP

| tDWR

» tCCD

QK |

3 Click the down-arrow button displayed with a specification parameter to view its current value,
get more information about it, and view options to modify its value.

In the screen below, the details and default value of the tRTP parameter is displayed.

Real-Time Compliance Tool User Guide



Loading, Configuring, and Selecting Compliance Tests 4

Edit Test Parameters

The values of any of the listed DDR3 speacification parameters can be overridden. Enter all valuas as an intager representing twice t

{CKD), (This is becauss there are two logic analyzer states per dock.)
For example, to st @ parameter to 10 docks, enter a value of 20,

Apply Parameter Values File...

w~ tRCD and tRP
A tRTP

To override this setting, either spply the appropriate
the walue below.

Default value: 10
[T Manually override value of tRTP

Enter value for tRTP (in LA states): | 10

w tDRW

RERD to PRECHARGE must be »= tRTP. According to the DDR3 specification,
Thus, it is dependent on target speed. Use the teble below to find

[8].4 |

Target speed Max {4 clocks, 7.5 ns) Clocks LE states
S00MH= 2 clocks 4 g
10eeMHz Sams 4 g8
1333MH= 7.5ns 5 10
1800MH= 7.Ens g 12
186EMHz 7.5ns T 14
2133MH= 7.Ens g 1g

group parameter values

it iz the max of 4 cl¢
the correct walue for tRTE:

file, or m

4 Select the Manually override value of <parameter> checkbox.
5 Specify a desired value of the parameter in the Enter value for <parameter> (in LA states) field.
6 Click OK.

Applying a Parameter Value XML File

In the Real-Time Compliance tool, load the required test group.
2 Click the Edit Parameters... button displayed in the Setup tab.

The Edit Test Parameters dialog box is displayed with the list of all the specification parameters
applicable for the test group.

Real-Time Compliance Tool User Guide 23
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4

The values of anv of the listed DDR3 specification parameters can be overridden. Enter all values as an integer

Loading, Configuring, and Selecting Compliance Tests

Edit Test Parameters

=] E

representing twice the number of clocks (CKOD). (This is because there are two logic analvzer states per dock.)

For example, to set a parameter to 10 docks, enter a value of 20,

Apply Parameter Values FlIE...l

o

b

e

tRASmInA

I

tRASman
tRCD and tRP
tRTP

tDRW

tDWP

tDWR

tCCD

CIK- |

3 Click the Apply Parameter Values File... button.

A list of predefined Parameter Value XML files provided with the tool is displayed.

Select a Parameter Value XML file that matches your bus speed type and click Open.
5 Click OK to acknowledge the success message.

-

(3]

Parameter values successfully applied.

OK

All the parameter values are automatically changed to match the bus speed for which the Parameter
Value file is selected.

You can view the most recent parameter file that you applied to the loaded test group in the Edit Test
Parameters dialog box.

:: Edit Test Parameters

The values of any of the listed DDR3 specification parameters can be overridden. Enter all values as an integer
clocks (CKO). (This is because there are two logic analyzer states per clock.)

For example, to set a parameter to 10 clocks, enter a value of 20

Apply Parameter Values F”E...l II"-.-"I::st recent parameter values file applied: DDR3 1086MHz Parameter Values I

Real-Time Compliance Tool User Guide



Loading, Configuring, and Selecting Compliance Tests

Specifying Test Execution Time

4

You can specify the time for which you want the tool to execute a test. The tool then automatically
stops the test execution after the expiry of the specified time and continues running the next test in

the sequence.

To specify test execution time
1 Click the Setup tab in the tool.
2 Load the test group for which you want to specify the execution time.
3 Click the Specify Time to Run Each Test... button.
The Specify Time to Run Each Test dialog box is displayed.

% Specify Time To Run Each Test o= | ]

Cefault Test Time

Enter the default amount of time to run each test.

Hours: 0 Minutes: 5 Secands: 0

Cherride Default Time Far Each Test
Select below to override the default run time for a test,

4 DDRA Tests
# | ACTIVATE to PRECHARGE must be == tRASmin

[] Cverride the default time for this test

Enter the amount of time to run this test.

Hours: | 0 Minutezs: |5 Secands: | 0

w | ACTIVATE to PRECHARGE/autoPRECHARGE rmust be < tRASmax
w | ACTIVATE to READ/WRITE must be »= tRCD

* | PRECHARGE to ACTIVATE must be == tRP

~ | READ to PRECHARGE must be »= tRTP

~ | READ to WERITE must be »= tDRW

» | WRITE to PRECHARGE must be == tDWP

“ | WRITE to READ must be == tDWR

2]

m

Total Estimated Test Run Time: Mo tests selected

[ Cloze

4

group.

Real-Time Compliance Tool User Guide

In the Default Test Time section, specify the execution time in hours, minutes, and seconds for
which you want a test to be executed. This time is applicable for each test in the loaded test
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4 Loading, Configuring, and Selecting Compliance Tests

5 To run different tests for different length of time, you can override the default execution time for
tests. To override the default execution time for a test:

a Click the down-arrow button displayed with the test in the Override Default Time for Each Test
section.

b Select the Override the default time for this test checkbox.
c Specify the execution time for the test.
6 Click Close.

Based on the time that you specify, the tool automatically calculates estimated total time for the
execution of all the tests that you selected in the Setup tab.

Test Time
Total Estimated Test Run Time: 14 Howrs 40 Minutes

Specify Time to Run Each Test...l

The actual execution time for tests can be less or more than the estimated total time
calculated by the tool based on factors such as:

Saving a violation trace during a test run can increase the execution time for the test if the
violation is found very close to the end of a test's run time.

If the maximum number of violations are detected for a test, the tool stops running that

test even if there is time remaining for the test execution. The test then runs for a shorter
amount of time than the specified time.
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Configuring the Tool’s Run Options

After loading and configuring the compliance tests that you want to run, you can configure the
Real-Time Compliance tool’s run options for the actions to be performed on detecting a compliance
violation. You use the Run Options tab of the tool to configure these options.

Real-Time Compliance Tool =]

Setup Fun Options | Run/Results |

Test Trigger Options
When a violation is found: I Save Trace and Continue Running j

Maximum violations per test: I 10

Save Trace Options

Save files in directory: I Browse...

Base filename: ||

To configure run options for the tool
1 Click the Run Options tab in the tool.

2 From the When a violation is found listbox, select the action to be performed on detecting a
violation. Besides reporting a compliance violation in the Run/Results tab, the Real-Time
Compliance tool can perform one of the following actions on detecting a compliance violation:

Stop running the current as well as remaining tests.

Save the violation trace in a Logic Analyzer configuration (.ala) file with a user-specified name
and location and continue running tests. Each time a violation is detected, the tool saves the
violation trace in a new file with the same base file name that you specified and appends _<n>
to the base file name to avoid overwriting the previously saved trace files. <n> represents the
violation number. For instance, if you specified the base file name as
DDR3ComplianceViolation, then the tool saves the first violation trace as
DDR3ComplianceViolation_0.ala and the next violation trace as
DDR3ComplianceViolation_1.ala.

Continue running tests without saving the captured data in a trace.

3 Specify the maximum number of violations that the tool can report for a test. The default value is
10. When the number of violations reported for a test reaches the maximum number allowed per
test, the tool stops the execution of that test and continues with running the next test in the
sequence. This allows you to control and limit the number of violation traces to be saved when a
violation is found repeatedly.

After reporting the maximum number of violations for a test, the test execution stops even if there
is time remaining for the execution of the test.

4 In the Save files in directory field, specify the complete path where you want the tool to save
violation traces. This field is enabled only when you select the Save trace and continue running
option from the When a violation is found listbox.

5 In the Base filename field, specify the base file name with which you want the tool to save violation
traces as logic analyzer configuration (.ala) files. For a violation trace, the tool appends a violation
number (starting with 0) to this base file name to save traces with unique file names.
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This field is enabled only when you select the Save trace and continue running option from the When
a violation is found listbox.
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5 Running the Selected Tests and Viewing Results

Running the Selected Tests

You use the Run/Results tab of the Real-Time Compliance tool to run the selected tests as per the
options configured in the tool setup.

Real-Time Compliance Tool [_ [0

Setup | Fun Options Run/Results |

Run Selected Tests

Status: Stopped
Total number of violations: 0
Estimated remaining run time: 14 Hours 40 Minutes

To run the selected tests
1 Click the Run/Results tab of the tool.
2 Click the Run Selected Tests button.

The tool starts sequential execution of selected tests on the real-time data captured by logic
analyzer module.

Real-Time Compliance Tool

Setup | Fun Options Run/Rasults |

Status: Running Tests

Total number of violations: 0

Estimated remaining run time: 14 Hours 39 Minutes 22 Seconds
[

£l DDR3 Tests  Starfed af 10/9/2012 1:26:23 AM
= ACTIVATE to PRECHARGE must be == tRASmin  Starfed af 10/9/2012 1:26:23 AM  Ended af: 10/92012
El Chip Select 0 Séarted af 10/Q2012 1:26:23 AN Ended aby 10/5/2012 1:26:52 AM
Bank 0  Started at 10/9/2012 1:25:23 AM  Ended at: 10/8/2012 1:26:52 AM
[l DDR3 Tests  Starfed af 10/9/2012 1:27:0%4 AM
= ACTIVATE to PRECHARGE must be >= tRASmIn  Starfed af 10/92012 1:27:04 AM
El Chip Select 0 Started at 10/9/2012 1:27:04 AM
Bank 0 Started at 10/92012 1:27:04 AM
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Stopping the Tool

Once started, the tool executes the selected tests for the time that you specified for test
execution and stops automatically after all the tests have been executed for the specified time.
To cancel the test run and stop the tool manually, click the Cancel button in the Run/Results tab.
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Viewing Results

The tool keeps reporting the test results in the Run/Results tab for each test. In the test results, the
test start and end time and the chip select and bank for which it was executed is displayed. On
encountering a violation, the tool displays the violation as follows:

Real-Time Compliance Tool =]

Setup | Fun Options Run/Results |

Run Selected Tests
Status: Completed
Total number of violations: 20
Estimated remaining run time: 5 Minutes
[F] DOR3 Tests  Sfarfed af I0/12/2017 3:04:11 AN Ended af: 10/12/2017 3:04:25 AM ﬂ

[l ACTIVATE to PRECHARGE must be == tRASmin  Starfed af 10/12/2012 3:04:11 AM  Ended at: 10/12¢
=l Chip Select 0 Started at 107122012 3:04:11 AM  Ended af: 10/123/2012 3:04:25 AM
Bl Bank 0 Started at 10/12/2012 Z:040:11 AM  Ended at: 10/12/2012 3:09:25 AM

f ) Violation Found: Time 10/12/2012 3:04:12 AM
Y ' Violation saved in file: C\RTC Tool\DDR3ViclationTrace_0.ala

&% viclation Found: Time 10/12/2012 3:04:13 AM
Sl Viclation saved in file: C:\RTC Tool\DDR3ViolationTrace_1.ala

f ) Vielation Found: Time 10/12/2012 3:04:15 AM
' Vinlation saved in file: C:\RTC Tool\DDR3ViolationTrace_2.ala

¥4 Viclation Found: Time 10/12/2012 3:04:16 AM
Sl Violation saved in file: C\RTC Tool\DDR3ViolationTrace_3.ala

f ) Vielation Found: Time 10/12/2012 3:04:17 &M
' Vinlation saved in file: C:\RTC Tool\DDR3ViolationTracz_4.ala

f : n Vielation Found: Time 10/12/2012 3:04:18 AM
L 4 Violation saved in file: C:\RTC Toel\DDR3SViolationTrace_5.ala

q > | Viclation Found: Time 10/12/2012 3:04:20 AM
N Vielation saved in file: C:\RTC Tool\DDR3ViolationTrace_6.ala

[ h Vielation Found: Time 10/12/2012 3:04:21 AM
' Violation saved in file: CA\RTC Tool\DDR3ViolationTrace_7.ala

\'-I Violation Found; Time 10/12/2012 3:04:22 aM
# Viclation saved in filex C\RTC Tocl\DDR3ViolationTrace_8.ala

Viewing a Violation Trace

If you have configured the tool to save violation traces, you can open the violation trace .ala file in the
Logic and Protocol Analyzer GUI and view the captured data with violation(s) in various viewers.

Exporting Test Results to a CSV file

You can export the test results displayed in the Run/Results tab to a CSV (Comma Separated Value)
file.
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To export test results

Running the Selected Tests and Viewing Results 5

1 Click File > Export Results... in the Real-Time Compliance tool.

2 Browse and specify the path and name for the CSV file in which you want to export results.

3 Click Save.

Format of a CSV File

The format in which tests results are exported is displayed in the first line of the exported CSV file.

Agilent Real-Time Compliance Tool Test Results

Start Time,10/112012 2:06:49 AM
End Time,10/11,/2012 2:06:58 AM

Total Wumber of wiolations, 2

Full Test mMame,start Time,eEnd Time,Mumber of wiolations,wiolation Time,wiolation

DDR4 Tests“ACTIVATE t0 PRECHARGE must be
DDR4 Tests“ACTIVATE to PRECHARGE must be
DDR4 Tests“ZACTIVATE to PRECHARGE must be
DDR4 Tests“ACTIVATE T0 PRECHARGE must be

Real-Time Compliance Tool User Guide

== TRAsminvChip select 0/Bank Group OWB
= tRASMINwChip select 0/Bank Group OWE
== tRASMINYChip Select 0/Bank Group OWB
== tRAsminvChip select O/Bank Group OWB
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6  Saving the Real-Time Compli-
ance Tool Setup

You can save the Real-Time Compliance tool’s setup in a XML file. Saving the setup saves the
settings that you configured in Setup and Run Options tabs of the tool as well as the test results
displayed in the Run/Results tab. Once saved, the test environment is available for future use by
loading the saved XML file.

To save tool’s setup

1 Click File > Save Setup... in the Real-Time Compliance tool.

2 Browse to the location where you want to save the setup XML file.

3 Specify a name for the XML file and click Save.

All the current settings displayed in the tool are saved in the specified XML file.

To load a previously saved setup

1 Click File > Load Setup... in the Real-Time Compliance tool.

2 Browse to the location of the XML file in which the required setup is saved.
3 Select the XML file and click Open.

All the settings and any test results saved in the selected XML file are displayed in the tool.
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6 Saving the Real-Time Compliance Tool Setup
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/- Creating Your Own Compli-
ance Tests/Test Groups

Besides running the compliance tests provided with the tool, you can create your own specific tests
and run these tests using the tool.

You can:
create a new test group XML file and create new test(s) within this test group.
create new test(s) and add these to an existing test group XML file

To create user-defined tests and test groups
1 Click Custom > User-Defined Test Utility... in the Real-Time Compliance tool.
The User-Defined Test Creator Utility is displayed.

User-Defined Test Creator Utility [_ (O

— Location for Mew Test
™ add to an existing Test Group File,
¥ Create a new Test Group File and add test to it.

Test Group File Information

Mew Test Group File name: I Browse...

MNew Test Group name: I

Mew Test Group description: |

— Test Infermation

Mame of new test: I

Description of new test: I

Logic Analyzer Trigger Specification
" Get current trigger specification from Agilent Logic Analyzer.
f* Get trigger specification from XML trigger file.

¥ML Trigger Specification File name: Emwse...l

Create Test | [ Close |

2 In the Location for New Test section, select where you want to create the test - in a new or an
existing test group XML file.

3 If you selected to create the test in a new test group file, specify the details of this new XML file.
These test group details will be displayed in the tool when you later load the test group.

4 If you selected to create the test in an existing test group file, browse and select the XML file.
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7 Creating Your Own Compliance Tests/Test Groups

5 In the Test Information section, specify the name and description for the new test. The test will be
displayed with this name in the tool when you later load it.
6 Select the source from which trigger specifications will be taken for the new test to trigger the
Logic Analyzer module.
Select Get current trigger specification from Keysight Logic Analyzer to use the trigger specifications
specified for the logic analyzer module currently used for capturing data on which tests are
run.
Select Get trigger specification from XML trigger file to use the trigger specifications specified in a
previously saved Logic Analyzer trigger specification XML file. To know how to save a trigger
sequence setup of a logic analyzer module in a XML trigger file, refer to the topic “To store a
trigger” in the Logic and Protocol Analyzer Online Help.
7 Specify the name and location of the XML trigger specification file if you selected the Get trigger
specification from XML trigger file option.

8 Click Create Test.
9 Click OK to acknowledge the test creation.

The tool creates the new test in the specified XML file. If required, you can further customize it by
editing the XML file directly.

Once created, you can load and run the new test in the tool in the same way as any other predefined
test.
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Troubleshooting Error Mes-
sages

Problem: Trigger specifications for a test not understood by Logic Analyzer

Description

While running a compliance test in the Real-Time Compliance tool, the Run/Results tab may display
an error message that the trigger specification for the test was not understood by Logic Analyzer.

Causes and Solution

The trigger specifications specified in the test's XML file are used to set the trigger specifications for
the Logic Analyzer module based on which the tool runs the test on captured data. At times, the
trigger specification from the XML file is not understood by Logic Analyzer because of one of the
following reasons:

For a predefined test shipped with the tool, the trigger specification is predefined. For such a test,
the cause of error can be:

- The test refers to a bus or a signal that does not exist in your current setup. In such a situation,
verify that the test is appropriate for your current setup and probing solution. The most
common occurrences of this problem is when either the CS# or CKE busses are not wide
enough. For instance, you may run a test for chip select 3 when there are only 2 chip select or
clock enable signals resulting in an error displayed for chip Select 3.

An incorrect value provided while manually overriding the default value of a test parameter in
the Edit Test Parameters dialog. For instance, a non-numeric value provided for a parameter
that requires a numeric value.

For a user-defined test, review the trigger specification that you specified for the test in its XML

file in addition to checking the above-mentioned possible causes.
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